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Introduction

Standard Telephone Features

The CounterPath X-Lite 4 for Mac softphone has all standard telephone features, including:

Call display and Message Waiting Indicator (MWI).
Speakerphone and Mute.

Redial, Hold.

Call history — list of received, missed, and dialed calls.

Enhanced Features and Functions

X-Lite 4 also supports the following features and functions:

Video

IM and presence using the SIMPLE protocol.

Managed contact list.

Automatic detection and configuration of audio devices.

Acoustic echo cancellation, automatic gain control, voice activity detection.
Support for the following audio codecs:

DVI4, DVI14 Wideband, G.711aLaw, G.711luLaw, GSM, iLBC, L16 PCM Wideband, Speex, Speex FEC,
Speex Wideband, Speex Wideband FEC.

Support for the following video codecs:
H.263, H.263+ 1998.

Automatic selection of the best codec based on the other party’s capability, the available bandwidth, and
network conditions. X-Lite 4 switches the codec within a call in response to changing network conditions.

Compliance to 3261 SIP standard.
STUN and ICE NAT traversal.
Support for DTMF (RFC 2833, inband DTMF or SIP INFO messages).
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2 Installation and Setup

2.1 Getting Ready

Account Information
After choosing a VoIP service provider, you will need the following information:

e User name and password

»  Authorization Name (if applicable)

» Domain

»  Firewall traversal and other network information; see “Configuring X-Lite 4” on page 25.

System Requirements
+  Operating System: Mac OS 10.5 or above operating system software.
»  Connection: IP network connection (broadband, LAN, wireless)

Multimedia Device Requirements

X-Lite 4 requires both speakers and a microphone to make calls. Any of the following configurations are
acceptable:

»  External speakers and microphone
e Built-in speakers and microphone
*  Dual-jack multimedia headset

»  USB multimedia headset

e USB phone.

X-Lite 4 is optimized to work with Apple iSight camera.
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2.2 Configuring X-Lite 4

Setting up your Account
After obtaining SIP account information from your VoIP service provider, you can set up your X-Lite 4 account.
1. From the menu, choose X-Lite 4 Beta > Preferences. The Application - Preferences window appears.

2. Click on Accounts and complete the User Details area with the information obtained from your VoIP
service provider.

Account

Account name: Account 1
Protocol: SIP
Use for: ™ call ™ IM/Presence

[General Voicemail Topology Presence Transport Advanced |

User Details

* User ID 6045550001

* Domain domainA.com

Password ssss

Display name _Joskph Santos

Authorization name

Domain Proxy
ERegister with domain and receive calls
Send outbound via:
@ Domain
-; Proxy Address

Dial plan  #1\a\a.T:match=1:prestrip=2;

Cancel ) ( oK 3

3. Complete the remaining tabs as specified by your service provider or to suit your setup. Settings that you
may need to change immediately include:

»  General tab, Domain Proxy area.
» Topology tab, if your computer is on a network and/or behind a firewall.
For more information, see “Configuring X-Lite 4” on page 25.

4. When done, click OK; the account is enabled and registered; check the account list to make sure the
account registers successfully.

Setting up for Voicemail

Your VoIP service provider may offer voicemail. If it does, then you can set up some voicemail features in X-
Lite 4. See page 27.
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Setting up a Contact List

Typically, you will want to create contacts in order to easily make calls and send IMs. See page 18.

2.3 Troubleshooting

X-Lite 4 includes tools for helping you troubleshoot problems. From the menu, choose Help > Troubleshooting.

Audio tab: While you are on a phone call, you can test the quality of the audio. Note that to perform a valid
test, you should be on an established call (not a call attempt).

Video tab: You can verify that your camera is working.
Network tab: You can verify that you are successfully connected to the network.

Devices tab: You can verify that your microphone and speakers are working and can set the volume to a
comfortable level without having to actually place a phone call.

Diagnostics tab: If none of the other tabs help you solve your problem.

2.4 Checking for X-Lite 4 Updates

To check for updates to X-Lite 4, choose Help > Check for updates. The Auto Update window appears.

If a new version of the software is available, you can download it from this window.
If no newer version is available, this window informs you that your version is up to date.
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3 Using X-Lite 4

3.1 The Onscreen Softphone

Minimize to dock )
Openlclose video

Close window window

X-Li

Showr/hide dial pad

Call entry field -
See pagi 9. (_i Enter 2 name or number -@ N Jﬁ ) The Call button

Resources.

See page 17 Contacts

5 C )
¥ Family (0)

¥Friends (0)
¥YWork (0)

Your free X-Lite softphone
expires on August 13, 2011

Resize softphone

(==}
4r? COUNTERPATH

X-Lite Beta Edit

Hide Toolbar T
Always On Top
Show Volume/Mic Levels
Show/hide resources tabs Show Message Archive
Hide Contacts 1r38C
Hide History 1r3eH

You can still receive calls when X-Lite is hidden or minimized.
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The X-Lite 4 Menu

X-Lite 4
About X-Lited

Preferences... 3,
Services »>

Hide X-Lite4 ¥H
Hide Others " 3#H
Show All

Quit X-Lited #0Q

The menu contains the following items that are specific to X-Lite 4:

e X-Lite > Preferences. This menu item lets you configure X-Lite to work with your VoIP service and lets
you change the way you work with X-Lite. See page 25.

* View. Change how X-Lite looks and show and hide specific modules.

e Contacts. Lets you work with contacts. Everything in this menu can also be performed directly in the
contact list.

e Action. Lists the actions that you can perform, depending on the current “state” of X-Lite. For example, ifa
contact is selected, it lists all the actions that can be performed on that contact.

» Help. Provides access to various service-related features. See page 43.

Receiving an Online Status Request

When you start X-Lite, one of the first things you may see (if availability is enabled) is an Online Status
Request dialog.

80N Online Status Request
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3.2 Placing a Call

You can contact someone using:

» Asoftphone address (for example, 6045550008 @domainA.com or kperera@domainA.com).
» Atraditional phone number, if supported by your VOIP service provider.

You can place one more call when another call is already in progress.

Call entry field

Auto complete suggestions

Click to place the call

Place the call. See the table on the next page.

Joseph Santos & Available :

EH: (o]l

| kok

¢ Kokila Perera 5045550001

expires on August 13, 2011

Call

'ﬁqﬁfbc:luu'rsnPATH

The outgoing call opens in its own call panel, below any other existing call panels. You will hear a ringing tone

while X-Lite attempts to make a connection.

How

From the...

Description

Keying

Dialpad or computer
keyboard

1. Enter the number or address in the call entry field using the dialpad
or the computer keyboard.

If entering a softphone address, you can enter the entire address
(6045550001@domainA.com or kperera@domainA.com) or just the
name (6045550001 or kperera).

As you type, a suggestion for completing the entry may appear.
Choose the suggestion or keep typing.

2. Click the Call button or press Enter.

Drag-and-drop contact or
previous call

Contacts or History tab

Drag an entry from the Contacts or History tab. (If the tab contains lots
of contacts, first search or filter the list.)

Control-click a contact or

Contacts or History tab

Control-click an entry from the Contacts or History tab and choose Call.

previous call (If the tab contains lots of entries, first search or filter the list.)
Redial Redial button « When the call entry field is empty, click the Call button.
¢ Or click the arrow in the call entry field and select a recent call.
An audio call is placed.
Dialing Dialpad 1. If the dialpad is not visible, click the Show/Hide dialpad button.

2. Click the numbers on the dialpad to enter the phone number.
3. Click the Call button or press Enter.
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Placing another Call

To place a new call (without hanging up on the current call), simply place the call in the normal way. A second
call panel opens below the current call. The first call is automatically put on hold.

Switch between the different calls by clicking Resume on the desired call panel. That call becomes the active
call and all other calls are on hold.

J

AN O X-Lite 4
Joseph Santos & On the phone -

BB
Enter a name or number e )

Existing call Call on Hold 00:14:54
Kokila Perera [6045550001]
New outgoing call Calling

: | Frank Chan
[ [Softphone: 6045550101]

important Notice

%CDUH'I'ERPATH

Ending a Call

Click the red End call button on the Call panel (the call can be active or on hold). The call panel closes after a
few seconds.

10



X-Lite 4 for Mac User Guide

3.3 Handling an Incoming Call

X-Lite must be running to answer incoming calls. (If X-Lite is not running, incoming calls may be directed to
voicemail; check with your VoIP service provider.)

As soon as an incoming call is received, a call panel appears, showing information about the call. The name and
phone number of the person calling you is displayed. In addition, the Call Alert box appears, even if X-Lite is
minimized.

800 X-Lite 4 =)

Incoming call

- Kokila Perera
[Softphone: 6045550001]

Stay connected and
upgrade today

e

[}
4N? COUNTERPATH

Action From the... Description

Answer Call panel or Call Alert box |Click Answer.

If you are on another call, that first call is automatically put on hold. You are
now talking to the new caller.

Decline Call panel or Call Alert box |Click Decline. There will be a busy signal. The call may be directed to
voicemail (if you have this service).

Video Call panel or Alert box The caller wants to include video.
Click to answer a video call and start sending your video immediately.

Audio Alert box The caller wants to include video.

Click to answer without video; if you want (and if you have a camera), you will
be able to add video later.

11
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3.4 Handling an Established Call

While the call is in progress you can:

» Control the audio: use the speakerphone, mute the call, control volume.
*  Put the call on hold.

Open or close the video window. If you close it, X-Lite stops
sending your video to the other party

Show/hide dialpad Audio controls

J

SN 5m X-Lite 4
Joseph Santos ¥ On the phone

Place another call (current call is { Enter a name or number ) [ call l - ]

automatically put on hold). See
page 10

Connected to 00:14:32
[P=m Kokila Perera
! A [Softphone: 6045550001]

Mute

.

Send an IM to this person (this
menu appears only if the user has
an IM address).

%CDUHTERPATH

12
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3.5 Handling Video Calls

Placing a Video Call

AN e X-Lite 4 —
Joseph Santos @ Available

B : B (o) 3]

| 6045550001 [ e [

Audio Call

Video Call

Call entry field

Click the down arrow and choose
Video call

Stay connected and

If you mostly make video calls, you
can Option-click this down arrow to
reveal the “Set Video Call as default
action” menu item.

‘&\?.'?CDUHTERPATH

How From the... Description
Keying Dialpad or computer 1. Enter the number or address in the call entry field using the dialpad
keyboard or the computer keyboard.

If entering a softphone address, you can enter the entire address
(6045550001@domainA.com or kperera@domainA.com) or just the
name (6045550001 or kperera).

As you type, a suggestion for completing the entry may appear.
Choose the suggestion or keep typing.

2. Click the arrow beside the Call button and choose Video Call.

Control-click a contact or |Contacts or History tab Control-click an entry from the Contacts or History tab and choose
previous call Video Call.

(If the tab contains lots of entries, first search or filter the list.)

Dialing Dialpad 1. If the dialpad is not visible, click the Show/Hide dialpad button.
2. Click the numbers on the dialpad to enter the phone number.
3. Click the arrow beside the Call button and choose Video Call.

Adding Video

If you have a camera, you can click Start Video to add video to an existing call. When you add video, the other
party may (or may not) start sending their video to you.

Other Party Adds Video

If the other party starts their video, the video panel automatically opens and the video is played. You can start
sending your own video, if desired (and assuming you have a camera) by clicking Start Video.

Pausing and Resuming Video

Click Stop Video or close the video window to pause sending your video.

Click Start Video to resume sending your video; the video window will open.

13
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Show/hide video window

8enNnn X-Lite 4 (=)
Joseph Sancos @ On the phone

Enter a name or number £ Call |=

M M Video call with Kokila Perera

Connected to 00:00:44
! Kokila Perera - Video
[Softphone: 6045550001]

* - [nd ]

oo
4r? COUNTERPATH

Start and stop your video

o
@Coumznmru

3.6 Voicemall

If your service includes voicemail and you have set up voicemail options (page 27), then when you have
voicemail messages, a number appears beside the voicemail icon at the top of the phone. You can click the icon
to automatically connect to voicemail and listen to your messages.

Voicemail icon

S5O0 X-Lite 4 —
Joseph Santos & Available -
8| |7 & =1t 3

-

Enter a name or number -l:;‘ Call =

14
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3.7 Instant Messaging

Instant messages are made using softphone addresses. Therefore, you can send or receive an instant message

(IM) to:

» Any contact who has a softphone address.
e Any party who phoned you from a softphone address.
*  Any party whom you phoned using a softphone address.

Sending an IM

1. There are several ways to select the person to send an IM to.

From the Contacts tab

Control-click on the contact and choose Send IM. The contact must have a
softphone address.

An active phone call

The person in the active phone call. Click & on the call panel for this phone
call.

The Instant Message window appears.

2. Type the message. Include emoticons and formatting, as desired.

To insert a return in the message, press Ctrl+Enter. (You can control the behavior of Enter and of

Ctrl+Enter; see page 34)

3. Press Enter.

800

Receiving an IM

When an IM is received, the IM window pops up.

Show Timestamps .

Call
Video Call

View/Edit Profile
View Call History

Delete Contact

15
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Viewing the IM Archive

To view the archive of incoming and outgoing IMs, from the menu bar, choose View > Show Message Archive.
The

16



4 Using the Resources

4.1 Contacts Tab

800 X-Lite 4 = |
Joseph Santos & Available

B

(| Enter & )| can [~

 —

LA @

Contacts History
Add a Contact & Q
¥ Family (0)
Search field ¥ Friends (4)
Emily Wilding

The availability of others.

& Frank Chan See page 21.

() Kokila Perera - Idle
€ Mayumi Suzuki
¥YWork (0)

Important Notice

&Couu‘rznm'ru

® X-Lite4 Edit View jeycidiy Actions Window Help
New Group

Filter and sort options Add Contact

Export Contacts

+ Show Offline Contacts
v Show Groups

v Minimum list
Expanded list

v Sort by Name
Sort by Online Status

Collapse All Groups

The Contacts tab displays your contacts and lets you specify multiple contact methods for them, including:
» Softphone address
*  Home phone number, business phone number, mobile phone number

You can identify one of these contacts as the primary contact method. When you double-click a contact, the
action associated with that method is performed: typically either phone or IM.

Contacts are typically organized into groups. X-Lite includes built-in groups: “Family”, “Friends” and “Work”.
You can add more groups, as desired.

17
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Managing Contacts and Groups

Adding a Contact

L4
Click , or control-click a group and choose Add Contact to Group. The Contact dialog appears. See the

table.
Click to change the type of phone number: Click + to add another phone number field
“Softphone”, “Home”, “Work” and so on Click - to delete the selected entry
.Tala Contact Editor
Contact Summary
Kokila Perera
Group: [ Friends - Primary Call | 6045550001@domainA.com | |+

Primary Presence: | 6045550001@domainA.com ?]

Display Name: | Kokila Perera | Softphone '_H b [
First Name: softphone & 6045550001 =
Last Name:

Presence:

604555000 1@domainA.cc... 13

| Cancel |[ oK |

Table 1: Contact Fields

Field

Description

Group

Click to show the list of groups and check each group to add this contact to.

Contact name

Only the “Display as” name is required. This is the name that will appear in the call panel and the Call
Alert when this person phones you.

Primary Call

If the contact has more than one number, select the primary number. This number will be used with the
single-click calling and control-click calling.

Primary Presence

If the contact has more than one Softphone or IM address, choose one entry as the primary presence. The
primary presence is used as follows:

« The presence icon on the contact list shows the online status for this address.
e The single-click and control-click actions for instant messaging use this address.

Softphone

Enter as many contact methods as you want. Use Softphone for somone who has a phone number that can
also be used for presence and IM; you will be able to IM this person and view their presence. Otherwise,
use Work, Home or another applicable method; X-Lite will not show a presence icon for this type of
phone number.

Adding a Contact using an Existing Address

You can add a contact by capturing existing information. On the History tab, select an entry that is not a contact.
Control-click and choose Add as Contact. The Contact dialog appears. Complete the dialog as desired and press

OK.

If the contact method is Softphone, an online status request is sent to this person. See “Sharing Availability” on

page 21.

18
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Changing Contact Information
To change the information for a contact, control-click the contact and choose Edit Profile. The Contact dialog
appears (see page 18).

Moving or Deleting a Contact
» To drag one or more contacts to a different group, select them and drag to the title bar of the new group.

» To delete one or more contacts, select them, control-click, and choose Delete or Delete Selected Items. The
contacts are removed from this group. If a contact belongs to several groups, it is removed from all groups.

Adding, Deleting or Renaming Groups

Select any group, control-click, and choose the appropriate menu item.

Using Contacts

Phone the person Control-click and choose Call, then click the desired number.

Send an IM Control-click and choose Send IM. See page 15.

You can watch the contact’s See Table 2 on page 23 for the meaning of the availability icons.
availability, if the contact has a . . . . L
softphone address See “Sharing Online Status” on page 21 for information on obtaining

availability information.

19
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4.2 History Tab

Incoming missed call

Outgoing call, either

attempted or established

Incoming call that was

answered

\NO ¥-Lite 4 —
Joseph Santos @ Available
B M

. Enter a name or number ) call -

N 2

Contacts History
(@ ) ET—
Statu Address Date A

Rita Santos Today 4:14 PM

Mayumi Suzuki
Mayumi Suzuki
Kokila Perera

Yesterday 5:50 PM
12-Aug-11 4:53 PM
11-Aug-11 10:58 AM

df&CI:IUH'I'EIlPATH

Managing the Lists of Calls

You can control-click on an entry in a list to:

o Delete the call.
» Delete all entries in this list.

» Edit the profile if the entry is a contact.
« Add as contact. The Contact dialog appears. For more information on this dialog, see “Adding a Contact
using an Existing Address” on page 18.

Phoning from History

You can control-click on an entry to place a call to this person, using the contact method that was used for this

call.

Filter list

20
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4.3 Sharing Online Status

You can publish your online status to contacts who have softphone address, and you can set up X-Lite to view
the online status of other contacts. Typical online statuses are available, on the phone, busy, and so on.

Availability of other people
Your availability

anm X-Lite 4 =
Joseph Santos & Available
EEr ()l

d Enter a name or number ) call -

 —

Cnh%cts H@w
£ @
This person has no icon T
because you are not :
subscribing to his availability YFriends (4)
Emily Wilding

& Frank Chan
) Kokila Perera - Idle
& Mayumni Suzuki

YWork (0)

Important Notice

&COUHTERPATH

Sharing Availability

Watching Others’ Availability

When you create a contact by entering details in the Contact, the contact is automatically set up so that you
share availability. As soon as the person is set up in this way in your contact list, X-Lite sends them a
notification request. The request asks that you be able to see that person’s availability. If the person allows this

request, then the icon beside their name (in your Contacts) becomes color coded, so you can determine their
availability.

Allowing Other Parties to See your Availability (Publishing your Availability)

Continuing from above, when the other person allows the notification request, your name is added to their
contact list. As soon as you are added to their list, a request is sent back to you requesting that they be able to
see you. X-Lite accepts this request automatically, and the other person can now see your availability.

21
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Receiving an Online Status Request

When someone who is not one of your contacts has you as a contact on their end, you receive an Online Status

Request.

The request appears to you as an Online Status Request. You must respond to the request:

» Allow the request and create a new contact using this address. This option is selected for you if you do not
currently have a contact with this SIP address.

« Allow the request and update the contact to allow the person to see your presence. This option is selected

for you if you already have a contact with this SIP address but you were not previously sharing presence
with this person.

N.Yole

Kokila Perera (6045550001) wants to communicate with you

Online Status Request

Kokila Perera

Friends

Button Result
Ignore The other person will not be able to see your availability. The Online Status Request may appear again in this
session or a future session
Allow The other person will be:

» Able to see your availability.
» Added to your contacts.
Because you allow the request, you will no longer be bothered by requests from this person.

In addition, this same request will automatically be sent from your X-Lite to the other person, so that you can
see their availability.

22
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Setting your Online Status

Changing your Status

Click the down arrow beside the availability indicator on X-Lite, and select the desired availability. See Table 2,
below. When your availability changes, the new availability is sent to your contacts.

K. YoXo) X-Lite 4 O
Joseph Santg @l T E

E[su o al

& Away
| Enize @ On the phone call n
& Offline
; Set Custom Status...
Nt
Contacts History
|
Table 2: Availability Indicators
Indicator Meaning for your Availability Meaning for Others’ Availability
Available Either: You can contact this person.
it * You have set your availability to this status.
e X-Lite has determined that you are logged on but not on the
phone or idle.
When you have this availability, X-Lite will automatically
detect when you are idle or on the phone, and change the
availability to match.
Busy You have set your availability to this status. X-Lite will never |You can contact this person.
] automatically switch you out of this status; you must switch
yourself.
Away You have set your availability to this status. X-Lite will never |You can contact this person.
automatically switch you out of this status; you must switch
yourself.
On the phone  |Either: You can contact this person.
o * You have set your availability to this status. In this case, X-
Lite will never automatically switch you out of this status;
you must switch yourself.
* You started a phone call when your status was “Available”.
When your call finishes, your status reverts to “Available”.
Idle You have not moved or clicked the mouse or pressed a You can contact this person.
keyboard key for the Idle period.
As soon as you click the mouse or keyboard, your status
changes to “Available”.
Offline You have set your availability to this status. The other person | The contact is either not logged on or else
sees you as offline, even though you are not actually offline.  |is not set up for availability.
The other person cannot tell the difference between this status
and you really being offline.
No icon Not applicable You are not watching the other person’s
availability.
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5 Configuring X-Lite 4

From the menu bar, choose X-Lite > Preferences. The Preferences window appears.

»  When configuring X-Lite the first time, click the Accounts tab and set up the account. Then complete other

tabs as desired.
»  After the initial setup, display whichever tab you want.

5.1 Configuring your Account

To set up an account and configure X-Lite to work with your VoIP service, from the menu bar, choose X-Lite 4

> Preferences > Accounts. The Accounts window appears.

Make sure the account is enabled Double-click the account to edit

;M r Preferences - Accounts

Y SR TR,

Alerts & Sounds Devices MNetwork Codecs Media Quality Advanced

Application ' Accourts
Enabled Status | Account Name Protocol | User ID call
i) @ Account 1 sIP 6045550008 @domainA.com &

25
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Accounts — General

Account

Account name: Account 1

Protocol: SIP

Use for: ¥ Call [ IM/Presence

[ General Woicemail Topology

Presence

Transport = Advanced

User Details

Fields with an asterisk are

* User ID 6045550001

required

* Domain domainA.com

Password sese

Display name _ Joseph Santos

Authorization name

Domain Proxy

lﬁﬂegister with domain and receive calls

Send outbound via:
) Domain

() Proxy Address

Dial plan  #1\a\a.T;match=1;prestrip=2;

Cancel ) ( ok )

Table 3: Accounts — General

Field

Description

Account name

If desired, change the account name to something that is meaningful to you. For example, the
name of the VoIP service provider.

Protocol Read-only. Always specifies SIP.

Use for Leave these fields checked.

User Details

User ID Provided by your VoIP service provider.

Domain

Password

Display name This name is displayed in the X-Lite title bar. Other people will see you as this name.

Authorization name

May not be required. If it is required, it will be provided by your VoIP service provider.

Domain Proxy

Register with domain and receive
calls

Check this box if you want to register with your VoIP service provider, so that you can receive
incoming calls.

Typically, this field is checked.

This field may be left unchecked when, for example, your level of service does not include the
ability to receive incoming calls. In that case, turning this field on may cause registration to
fail (when you close the Account Properties window), meaning that your X-Lite cannot
register with your VoIP service provider.

Send outbound via

Choose the setting specified by your VoIP service provider:

< Domain: If your VoIP service provider requires that traffic be directed to proxies that are
discovered via the domain.

« Proxy Address: If your VoIP service provider has an outbound proxy address and requires
that you provide the address to X-Lite. For the address enter a domain name (for example,
domain.com) or an IP address (for example, 123.456.789.012).

If you are using X-Lite in a test lab, it is possible that neither of these settings is suitable; see
page 33 for a third way to direct traffic.

Dial Plan

See page 47.
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Accounts — Voicemail

Account

Account name: |Account 1
Protocol: SIP
Use for: [ Call ™ IM/Presence

! General Voicemail Topology Presence Transport Advanced |

WVoicemail
™ Check for voicemail
Number to dial for checking voicemail ||
Number for sending calls to voicemail

[Tl send calls to voicemail if unanswered for 0 seconds

(" cancel ) f OK )

These settings let you set up to interact with your VoIP service provider’s voicemail service. They also let you
configure X-Lite to forward calls in several situations, independent of your VOIP service provider’s voicemail
service.

Your service provider may provide the ability to set up for voicemail outside of X-Lite, for example, by phoning
a softphone address and following the voice prompts, or by accessing a website.

Check with your service provider to determine if another setup mechanism is available. If so, check what the
settings are in that setup, and make sure you enter compatible information in X-Lite.

In particular, if your service provider has a mechanism for call forwarding, find out if you should leave the
Forwarding settings on this Voicemail tab blank.

Table 4: Accounts — Voicemail

Field Description

Check for voicemail Set the checkbox in one of these ways:
» Check the box if X-Lite must subscribe to be notified when there is a voicemail for
you. In other words, to configure for “subscribe for message waiting”.

« Clear the checkbox if the service provider’s voicemail server sends notifications
without X-Lite subscribing. In other words, to configure for “implicit subscription”.

 Clear the checkbox if the service provider does not support voicemail.
Check with your VoIP service provider for the correct configuration.

\Voicemail is offered by your VOIP service provider; it is not part of X-Lite. Contact your
service provider for information on using voicemail.

Number to dial for checking voicemail |Optional, but complete this field only if your VoIP service includes voicemail.

« Completing this field activates the ﬁ icon on the softphone. When you click the
w icon, X-Lite will dial this number. You will be connected to your service
provider’s voicemail and can listen to your messages.

« If you leave this field empty, then this icon will not work; you will have to manually
dial this number in order to connect to voicemail.

Enter the number or SIP address provided by your VoIP service provider.
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Table 4: Accounts — Voicemail

Field Description

Number for sending calls to voicemail |Complete only if your VOIP service includes voicemail. Optional, but you must
complete it if you check “Send calls to voicemail if unanswered”.

This is the number that incoming calls will be forwarded to if they are unanswered after
the specified interval (below).

If you leave this field empty, then X-Lite will never forward calls to your service
provider’s voicemail. However, most VoIP service providers have their own mechanism
for sending unanswered phone calls to voicemail. So leaving this field blank does not
mean that forward-to-voicemail does not work.

Enter the number provided by your VoIP service provider.

Send calls to voicemail if unanswered |Complete only if your VoIP service includes voicemail.
To send to voicemail after the specified number of seconds.

Your service provider may also provide a similar feature that is set up outside of X-Lite.
If s0, make sure you do not enter competing information in X-Lite and in the service
provider’s user interface. For example, if you turn off this field, make sure the same
feature at your service provider is also turned off. Otherwise, all your calls will continue
to be forwarded.
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Accounts — Topology

Account

Account name: Account 1

Protocol: SIP

Use for: [ Call ™ IM/Presence

[ General Voicemail

Topology Presence Transport Advanced |

Firewall Traversal

Firewall traversal method (*) Auto-detect (ICE, recommended)

(O Discover public IP address (STUN)
() Use media relay (TURN)
() None (use my local IP address)

To use domain server, leave Server Address blank

Server address

User name

Password

" Range of ports used on local computer 0 -0

_f Cancel ) ( oK ]

Table 5: Accounts — Topology

Field

Description

Firewall traversal
method

Leave the default. Or if you have problems making phone calls, contact your VOIP service provider for
information on which of the other options might work:

Auto detect using ICE: Automatically determine the contact address for signaling traffic.

Advertise the local IP, public IP (discovered via STUN, if available), and media relay IP (discovered via
TURN, if available), and use these to automatically determine the best route for media traffic during
calls.

Discover public IP address: Advertise the public IP address (discovered via STUN) for the contact
address for signaling traffic, and for the connection address for media traffic.

Use media relay (TURN): Advertise the public IP address (discovered via STUN) for the contact address
for signaling traffic.

Advertise the address of a media relay server (discovered via TURN) for the connection address for
media traffic.

None: Advertise the local IP address only for both signaling and media traffic.

Server address

Empty: Discover the address of the firewall traversal server (the STUN or TURN server), if available,
using DNS SRV.

Specified: Use the firewall traversal server specified as either an IP address or a fully qualified hostname.

Range of ports

The appropriate setting depends on your computer setup:

Checked: If your computer is behind a restrictive firewall that only allows specific port ranges to be
used. Enter the range of ports to use for your SIP account. (You must also open those ports on your
firewall; refer to applicable firewall documentation for information.)

Unchecked: If your computer is not behind a restrictive firewall.
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Accounts — Presence

Account

Account name: |Account 1
Protocol: S|P
Use for: ECaI[ E‘IMIPresenr_e

| General  Voicemail  Topology | Presence | Transport  Advanced |

Presence

Mode | Peer-to-peer

ke

Poll time | 300 seconds

Refresh interval 3600 seconds

( Cancel ) C0K—)

Presence allows your contacts to see your online availability and allows you to see the online availability of
contacts. See “Sharing Online Status” on page 21.

Table 6: Accounts — Presence

Field Description
Mode Choose the setting specified by your VoIP service provider:
« Disabled: Presence is not supported.
* Peer-to-Peer.
Poll time

Enter the value specified by your VoIP service provider.

Refresh interval

Enter the value specified by your VoIP service provider.
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Accounts — Transport

Account

Account name: |Account 1
Protocol: SIP
Use for: W call ™ IM/Presence

| General  voicemall Topology  Presence  Transport | Advanced |
Transport

Signaling transport [ Automatic |‘3”-!

(" Cancel ) C OK )

Contact your VoIP service provider to identify the types of transport that are supported. Then choose a
supported transport:

» Automatic: X-Lite sets up the transport based on the capabilities of the network and the X-Lite computer.
Choose this option if you do not care which transport is used.

. TCP
- UDP

31



CounterPath Corporation

Accounts — Advanced

Account

Account name: Account 1

Protocol: S|P

Use for: W call W IM/Presence

| General  voicemail

Presence Transport Advanced

Register Settings

Reregister every 3600 seconds
Minimum time 20 seconds
Maximum time | 1800 seconds
Timers
"1 Enable Session Timers
Session Timer Preference | None i--ﬁv-l
Default Session Time 60 seconds

Advanced Options

™ Send SIP keep-alives

E Use rport

"1 Use old style hold

"1 Send outgoing request directly to target

{j Cancel ) ( OK }

Table 7: Accounts — Advanced

Field

Description

Register Settings

Reregister every

The time interval between X-Lite’s attempts to reregister in order to refresh the account
registration with the VoIP service provider for this account. A value of zero means not to
reregister after the initial registration.

This value is placed in the “Expires” header field of the REGISTER message.

Minimum time

If the reregistration fails, X-Lite will wait this amount of time, then attempt to reregister. If the
second attempt fails, X-Lite will wait twice this time and try again, then four times this time, and
so on, until reregistration succeeds.

Maximum time

This is the maximum wait time between attempts to reregister. Once this maximum is reached, X-
Lite will wait this time for all subsequent attempts.

For example, the min. time is 20 secs, the maximum time is 120 secs. X-Lite will attempt to
reregister as follows:

e Wait 20 secs.

e Attempt to connect.

« |f fail, wait 40 secs.

e Attempt to connect.

« |f fail, wait 80 secs.

« Attempt to connect.

« If fail, wait 120 secs (the maximum)
e Attempt to connect.

« |f fail, wait 120 secs, and so on.

Timers

Enable session timers
Default session time

A session timer is a mechanism to detect whether a call session is still active from the signaling
point of view. When the timer expires, a refresh is sent from one party to the other. The timer is
then reset.

« Turn on to enable session timer. Enter a value in Default session time.
« Turn off to disable session timer; refreshes will never be sent.
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Table 7: Accounts — Advanced

Field Description

Session timer preference This field specifies your preference for which party should send the refresh. The preference is not
a guarantee that the refresh will be performed by the specified party. The choices are:

» None: No preference.
« Local refreshes: Your computer sends.
* Remote refreshes: The other party sends.

* UAC refreshes: The user agent client (the party that initiated establishment of the
communications) sends.

e UAS refreshes: The user agent server (the other party) sends.

Send SIP keep-alives Typically on, to instruct X-Lite to send SIP keep-alive messages in order to maintain a “pinhole”
through your firewall for SIP messaging.

Use rport Typically on.

Send outgoing request When checked, requests with a complete URI (user@ABC.com) go to ABC.com and the “Send

directly to target outbound via” field on the General tab (page 26) is ignored.
If you check this field, make sure you also set “Send outbound via” (on Accounts > Account) to
“Domain”.

Typically off. This field is intended for test labs and may cause problems in a NAT environment.

Use old style hold Check this box only if your VolIP service provider advises you to do so.
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5.2 General Preferences

From the menu bar, choose X-Lite 4 > Preferences. The Preferences window appears. All the tabs on this

window except for “Accounts” are preferences tabs. These tabs let you control the way that you work with X-
Lite.

Preferences — Application
(_Hella Preferences - Application

L Y o8l B g

erts & Sounds Devices Network Codecs Media Quality Advanced

General Preferences

[2‘] Pause iTunes when making or receiving calls

Messages & Presence

[2{ Display idle status if | don't use my computer for 10 minutes
In messaging, pressing Enter will

@ Send the message (Use Ctrl + Enter to create a line)
() Create a new line (Use Ctrl + Enter to send)

This panel lets you set your preferences for general GUI behavior.
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Preferences — Alerts & Sounds
@00 Beefceces Al s A Souad

Alerts

™ Enable alert displays

Display alert information

For an incoming call

For an incoming Instant Message
When a contact comes online
When a contact goes offline

EREE

Sounds
# Enable sounds

Play sounds

For an incoming call

For call waiting

For hangup

For an incoming Instant Message
When a contact comes online

EEEER

Sound preference [N o

( Browse... ) [ Reset )

D

This panel lets you control the alert box and lets you assign sounds.

Enable Alert Displays

You can control whether the Call Alert box is displayed in different situations. You can also control how you
are alerted to an incoming IM: either with a small IM Alert box or with the IM window itself.

Assigning Sounds

You can assign specific sounds to a variety of actions or “events”.

1. Select the Enable sounds check box and select the check boxes for each desired event, or clear the Enable
sounds check box to disable all sounds.

2. If enabling sounds, you can change the sound for each event: select the individual event. The value in
Sound preference will change. Select the desired sound.

You can import sounds; these will be added to the list of sounds you can choose from when assigning a sound to
an event.
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Preferences — Devices
@800

{: Headset Mode | Speakerphone Mode  Other Devices |
Microphone: [ Built-in Microphone m
Speaker: f Built-in Output H
# Zero touch device configuration

X-Lite automatically detects devices at each startup, and selects the most appropriate device for each purpose. If
you do not like this selection, you can override it on this panel.

If you override a selection, it will apply the next time you start X-Lite, unless the device is no longer available,
in which case X-Lite will again select the device to use.
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Field

Description

Headset Mode

Microphone,
Speaker

Change these fields only if you want to override the devices that X-Lite automatically selected.
In both these fields, select the headset you are using.

The headset is the device that is usually used for audio out (the sound you hear) and audio in
(recording your voice). The only situation in which the headset is not used is when the Speaker
Phone button on the dialpad is pressed.

Therefore, unless you will always be using X-Lite in speakerphone mode, you must make a
selection here.

Select the headset in both the Speaker device field and Microphone device field.

Zero-touch device
configuration

Typically, leave on. When device configuration is on, if you change your audio device, X-Lite will
automatically detect the new device and start using it.

Test Devices

See “Troubleshooting” on page 43.

Speakerphone Mode

Microphone

Change this field only if you want to override the devices that X-Lite automatically selected.

Make the appropriate choice:

» Select the device that you want to use for audio in (recording your voice) when the Speaker
Phone button is pressed.

It can be any microphone: it does not have to be the microphone on the device you specified as
the speaker device. For example, it can be the microphone on your camera.

« Select None if you do not have a speaker phone. The Speaker Phone button on the dialpad is
disabled.

Speaker

Change this field only if you want to override the devices that X-Lite automatically selected.
Make the appropriate choice:

» Select the device that you want to use for audio out (the sound you hear) when the Speaker
Phone button is pressed. Make sure you select a speaker device (not the headset).

» Select None if you do not have a speaker phone. The Speaker Phone button on the dialpad is
disabled.

Other Devices

Ring on The device where you want to hear the phone ringing.
Change this field only if you want to override the devices that X-Lite automatically selected.
\Volume The volume of the ringer.
Camera This field appears only on versions of X-Lite that include video functionality.
Change this field only if you want to override the devices that X-Lite automatically selected.
Select the camera model.
Resolution Leave at standard, or change the size as follows:

« Setitto high if you have a good camera and a computer with a fast CPU. You will know that you
have set the size too large if:

Your computer slows down (the video is using too much CPU)
The video shows black areas or is slow or jerky.

« Typically set it to low only in special situations, for example, when using wi-fi in a hotel. You
will know that you have set the size too small if the video is fuzzy.

This field is identical to the Resolution field in Media Quality > Video Quality.
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Preferences — Network

| 80N Preferences - Network

o 4 I 8|8 @
" s & Sounds Devices Codecs  Media Qu

Network Connection Speed

() Dial-up or ISDN

(0 Cable, DSL or ADSL

® Fast cable, DSL or ADSL
() Local area network (LAN)

O Custom
Sending bitrate: 32K ——( ) = 5M 512000
Receiving bitrate: 32K  ——( ) - 5M 512000

Select the type of network connection for your computer.

The sliders move to show the bitrate that will be used for sending and receiving. These rates are typical rates for
the selected configuration.

If you know that your computer and network can handle a faster sending speed, click Custom and move the
slider. It is recommended that you not change the receiving speed.

* You will know that you have set the sending speed too high if the remote audio is garbled.
* You will know that you have set the sending speed too high if:

*  The remote video shows black areas or is slow or jerky.

»  The remote audio is garbled.

* You will know that you have set the sending speed too low if the audio is good but the video is of poor
quality (grainy).
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Preferences — Codecs

Audio Codecs

[ N B Preferences - Codecs
La IF & & e o
) i (=)
"8 Dy 4 @1 ’ ' -
i i Alerts & Sounds Devices MNetwork Codecs Media Quality Advanced
[ Audio Codecs | Video Codecs |
Codecs Selected Codecs
DVi4 C711 alaw
DVI4 Wideband G711 uLaw
GSM
L16 PCM Wideband =
Speex =
Speex FEC
Speex Wideband y
Speex Wideband FEC -
Select a codec from the above lists to view properties
Description:
Fidelity:

Bitrate range (bps):
Best Quality (PESQ)
0.0

] Accept the first codec offered when negotiating audio codecs.
(Try this setting if there is no audio for a particular call.)

You can enable and disable codecs. If a codec is . the

il ir an codec is actually used.

4.5

speed (at the time the cail is made or

This panel shows all the codecs that are included in X-Lite. You can enable or disable codecs as desired.

With only one codec enabled, all calls made will use that codec. With more than one codec enabled, X-Lite
automatically chooses the best codec based on the other party’s capability, the available bandwidth, and

network conditions.

You cannot change the properties of any codecs.

About Codecs

Audio codecs describe the format by which audio streams are compressed for transmission over networks.
Codecs can be categorized as either narrowband or wideband:

* Narrowband codecs work with low bandwidth such as a dialup internet connection. These codecs have a

sampling rate of 8 kHz.

»  Wideband codecs work with high bandwidths and result in better audio quality. However, they do not work
with PSTN. These codecs have a sampling rate of 16 kHz.

Supported Codecs

Codec

Narrowband

Wideband

Broadvoice-32

Broadvoice-32 FEC

DVI14 v

DV14 Wideband

G.71laLaw *

G.71luLaw *

GSM

iLBC

L16 PCM Wideband

Speex

NN EEN EEN EEN EEN BEN RN

Speex FEC
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Codec Narrowband Wideband
Speex Wideband 4
Speex Wideband FEC 4
* Generally, at least one of these codecs must be enabled in order to place a PSTN (land line) call.

Video Codecs

Video codecs describe the format by which video streams are compressed for transmission over networks.
Some codecs require less bandwidth than others, but may result in lower video quality.

You can enable or disable codecs as desired. You may decide to disable a codec even though your VoIP service
provider supports it.

With only one codec enabled, all calls made will use that particular compression format. With more than one
codec enabled, X-Lite automatically chooses the best codec based on the other party’s capability, the available
bandwidth, and network conditions.

You cannot change the properties of any codecs.

Supported Codecs
« H.263

*  H.263+1998
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Preferences — Media Quality

eo0n

e, 28 E ¥y

Preferences - Media Quality
_d
A Ig v

[ Audio Quality | Video Quality |

El Reduce echos from speakers (AEC)

# Reduce background noise
E‘Automatic gain control

"1 Preserve bandwidth during silent periods

Field

Description

Audio Quality

Reduce echo

Turning this feature on improves sound quality. This feature is typically on.

Reduce background noise

Automatically attempts to remove background noise.
Typically on for the speakerphone.

Automatic gain control

This feature is typically on.

Preserve bandwidth

When this feature is on, X-Lite stops sending audio when you are not talking.

When this feature is off, X-Lite always sends audio, which uses more bandwidth but may result in
better call quality.

Typically off. However, if you are using a slow (dial-up or ISDN) connection, you may want to turn
iton.

Video Quality

Resolution

Leave at standard, or change the size as follows:

« Setitto high if you have a good camera and a computer with a fast CPU. You will know that you
have set the size too large if:

Your computer slows down (the video is using too much CPU)
The video shows black areas or is slow or jerky.

« Typically set it to low only in special situations, for example, when using wi-fi in a hotel. You
will know that you have set the size too small if the video is fuzzy.

This field is identical to the Resolution field in Devices > Other Devices.
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Preferences — Advanced

@00

DTMF

(® Send via DTMF 2833 M Also send in-band
() Send in-band

RTP

"1 Enable RTP inactivity timer

Preferences - Advanced

Time: 300 seconds
Field Description
DTMF You may need to change the DTMF configuration if you cannot interact with interactive
voice response systems (auto attendants, voice-activated menus, and so on).
Contact your VoIP service provider for the correct setting.
RTP This timer controls how calls are disconnected when X-Lite determines that there is a

problem with the call and the other party has probably disappeared (assuming that you
have not yourself detected the problem and hung up manually).

Typically, the timer is enabled. It is recommended that you not disable it.
You can change the length of the timer, but do not set it to less than 30 seconds.
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A Troubleshooting

Choose Help > Troubl

eshooting to display the Troubleshooting window.

Testing Audio Quality

While you are on a phone call, you can test the quality of the audio. Note that to perform a valid test, you should
be on an established call (not a call attempt).

ac

Audio Quality

nSZ 8

Troubleshooting - Audio

e

Refresh

@ You are sucessfully registered with a SIP server.

@ Audio sent and received OK.

@ Your audio quality is good

Call statistics from: August 12, 2010 4:12:23 PM PDT (CA)

Incoming Bandwidth
Outgoing Bandwidth

Local audio codec

Remote audio codec:
Received MOS:

Audio layer latency:
Network layer latency:
Audio received:
Audio lost:

Audio dropped:

: 68 kbps

: 68 kbps

: grtiu
grifu
Unavailable
0ms

15 ms

7 packets

1 packets
0 packets

Still having problems with your audio quality?
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Testing Video Quality

While you are on a phone call, you can test the quality of the video. Note that to perform a valid test, you should
be on an established call (not a call attempt).

Video Quality ( Refresh )

@ You are sucessfully registered with a SIP server.

i Call statistics from: August 12, 2010 5:09:57 PM PDT (CA)

Local video codec: H263-1998
Incoming Bandwidth: 398 kbps
Remote video codec: H263-1998
Outgoing Bandwidth: 146 kbps
Video received: 210 packets

Video lost: 2 packets
Local video processed: 236660 packets

il hawvin blems with your video qu

Testing the Network Connection

You can verify that you are successfully connected to the network.

Network Status ( Refresh )

@ You are connected to the internet

@ Your firewall is setup for calling

| Thursday, August 12, 2010 5:10:44 PM PT (CA)

Public IP address:
Firawall Type: Non-symmetric NAT

Stilf having problems with your Network?
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Testing Devices

You can verify that your microphone and speakers are working and can set the volume to a comfortable level
without having to actually place a phone call.

Headset Setup

1. Select the microphone you want to use:
] [ Built-in Microphone H

2. Speak into the microphone:
-

& Evaluating, please speak into the microphone.

(: Switch to "Speaker Setup®

1. Select the speakers you want to use:

&b [ Built-in Output # (Pay )

2. Adjust your volume to a comfortable level:

'# e

| No sound? |

@ Evaluating, play the test sound.

Stilf having problems with your device ?
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Diagnostics

Only use this panel if instructed to do so by your support representative at your VoIP service provider.

‘®0nN Troubleshooting - Diag

Still having problems?

For more support information: CounterPath support FAQ or

Start diagnostic logging. (__ Start Logging...

Access reports or send them to us and we will try to help. (_ SendReport.. | [ Open Reports Folder |

To start logging X-Lite activity and send a logging report to customer support:
1. Click Start Logging. The first Diagnostics Logging window appears.

Select the problem you are experiencing and click Start Logging.

On the second Diagnostics Logging screen, click Finish. Logging will start.

Perform the actions you want to capture; for example, attempt to make a phone call.

a M w Db

When done, display the first Diagnostics Logging window again and click Send Report. A window opens;
select the report and click Open. When the report is successfully sent, a confirmation message appears on
the first Diagnostics window.

6. Click Stop Logging. Close the Troubleshooting window.

Describe the problem by choosing a problem type listed under one of the following categories

» Starting the application
¥ Phone calls and Audio
| am not getting incoming calls

| can't make outgoing calls
My calls get dropped
Audio is lost
| am experiencing one v
Audio quality is poor
Another problem

» Device

» Conferencing

L Messagina/Online Status

Logging has started. Try using the feature that caused the problem.

To send a diagnostic log report return to the Trouble shooting Diagnostic screen and
Send Report from there.

The log files will be sent with the problem description. Log files may contain personally
identifiable information, but these files will be used only to help diagnese and resolve issues
and no other purposes.

i 80N Troubleshooting - Diagnostics

Still having problems?

For more support information: CounterPath support FAQ or

Start diagnostic logging. (. _Emp Logging |

Access reports or send them to us and we will try to help. | SendReport.. | | Open Reports Folder |
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B Dial Plan

You can create a dial plan to modify the the call input (what you type, select or drag onto the call entry field) to
ensure that the call gets placed successfully. Modifying the input is useful when using numbers from a contact,
which may include symbols such as the + symbol.

Do You Need to Read this Information?

You do not have to read this dial plan information if the default dial plan behavior (below) is acceptable.

If you need to modify the input (for example, to prefix the number with “9”), then you must create a dial plan.

The Default Dial Plan

The default dial plan is:
#n\a\a.T;match=1;prestrip=2;
where #n is the account prefix; in other words #1 for the first account and so on.

X-Lite supports only one SIP account, so there is no point in including the #1 when you place a call. However,
if you are used to eyeBeam, you may be used to entering #1. This dial plan supports that habit: the dialplan
removes the #1 and then places the call on the SIP account.

B.1 Dial Plan Activity

When you make a call, X-Lite takes the phone number (the input) and performs the following:

» Cleanup. This step is not part of the dial plan: it is always performed even when there is no dial plan.

Input is cleaned up by removing spaces, dashes, open brackets, and close brackets. Cleanup allows X-Lite
to support calls placed using contacts from a contact list, including Microsoft® Outlook®.

» Matching. X-Lite compares the input to the patterns in the dial plan. If a match is found, the transformation
associated with the pattern is peformed.

« Transformation. If a match is found between the input and a pattern, that pattern’s transformation (if any) is
peformed.

»  Place Call. Then the call is placed using the transformed input.

B.2 Dial Plan Syntax

The dial plan has the following syntax:

pattern[|pattern];match=1;<transformation>=<value>;[match=2;
<transftormation>=<value>;]

Where:

e ltemsin[] are optional.
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« Pattern: the pattern that will be matched. One or more patterns. Each pattern is separated by a | pipe. The
pipe is optional after the last pattern. Each pattern is implicitly numbered, starting from 1.

» Match; Transformation: A pair that identifies the pattern number to compare with the input, and the
transformation to perform on the input when a match is obtained. The transformation is optional (meaning
that if there is no transformation for a pattern, then the input that matches this pattern is not transformed).
One or more pairs.

“match=""is a literal. “n” identifies the pattern. “transformation=""is replaced by a keyword, see below.

“value” is replaced by a value.

Spaces are allowed only in the <value> items.

Remember that dial plans are applied after the input has been cleaned up!

Example

\a\a. T | xxxxxxxxxx;match=1;prestrip=2;match=2;pre=8;

where:

* \a\a.T is the first pattern.

* XXXXXXXXXX; is the second pattern.
 match=1;prestrip=2; is the first match-transformation pair.
* match=2;pre=8; is the second match-transformation pair.

Pattern

Valid Content

The content for a pattern follows the digit map rules of RFC 2705, supplemented by the rules for regular
expressions. Where there is an overlap between the digit map and regular expression rules, the digit map rules
apply. For this reason, there are some special cases, included in the table below.

The following table describes the most common elements. All regular expression elements are supported.

Element Origin Description
| Regular Pipe character, used to separate patterns.
expression rules
0123456789 |Literals Literal digits, used as is.
#*atoz Literals Literal characters, used as is. Special cases:
» The literal x character is represented by \x.
» The literal t character is represented by \t.
X Digit map rules | Wildcard for any single digit, 0 to 9.
\a Regular Wildcard for any single alphanumeric character.
expression rules
[digit-digit] Regular A digit within the specified range.
expression rules
[character- Regular A character within the specified range.
character] expression rules
[digitd, digit2, Regular One of the characters in the collection.
digit3] expression rules
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Element

Origin

Description

Digit map rules

Repeat the last element 0 or more times. For example, xxxx. means repeat the last x 0 or
more times, which means this pattern matches three or more digits (not four or more
digits)! Use of this element results in a pattern with “minimum requirements”.

Digit map rules

A timeout period will take place before automatic dialing starts.

The T timer forces X-Lite to wait after a match is made. This timer should always be
included in these situations:

» Any pattern that uses the . (dot). For example, if the pattern is xxxx. then adding a
timer lets you type three or more digits. If there is no timer, then as soon as you type
three digits, X-Lite makes the match as soon as you type three digits.

» Any dial plan that has two patterns that are similar in elements but different in length.
For example, if one pattern is xxx and the other pattern is xxxxxxx, then adding the
timer lets you continue typing past three digits, in order to get a match on the second
pattern.

In this situation, the T timer should be included in the shorter pattern.

Transformation Keywords

Keyword Description
prestrip Strip the first n characters from the input before placing the call.
poststrip Remove n number of characters from the end of the input before placing the call.
pre Add the specified prefix to the input before placing the call.
post Attach the specified postfix to the input before placing the call.
replace Replaces the input with the specified string before placing the call.

Order of Transformations

These transformations are always performed in the following order (the order in which the transformations are
entered in the dial plan is not significant):

prestrip > poststrip > pre > post > replace

B.3 How the Input Is Processed

Comparing Input to the Dial Plan Patterns

The input is compared to the dial plan. Keep in mind that the input being compared is different depending on
whether the input is dragged/selected or typed:

« If the input is dragged or selected, then the entire input is compared to each pattern.

» If you are typing the input, then the digits are compared one by one as they are entered. Each time a new
digit is entered, the comparison starts over again.
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Results of the Comparison

X-Lite finds a match according to the following rules.

Type of Match

Result If User Presses Enter or Call |Result if User Stops typing

The input matches the pattern and the The transformation is performed. X-Lite |Nothing happens even after the T timer

pattern does not include the T timer attempts the call. has expired.

The input matches the pattern and the The transformation is performed. X-Lite |The transformation is performed. X-Lite 4

pattern includes the T timer attempts the call. attempts the call.

The input does not match the pattern No transformation is performed. X-Lite |Nothing happens even after the T timer
attempts the call. has expired.

B.4 Examples

Example 1

\a\a. T xxxxxxx.T;match=2;pre="9"

This simple example shows how to differentiate between a PSTN number and a softphone address, and how to
add a “9” dialing prefix only to the PSTN number.

Example 2

SXXT | LXXXXXXXXXX | [2-9 ] XXXXXXXXX | +X . T ;match=2;pre="9";
match=3;pre="91";match=4;prestrip=1;pre="9011"

3xxT The first pattern is any three-digit number beginning with 3. No transformation. The
assumption is that this is an internal extension. The timer forces X-Lite to wait after detecting
a three-digit number beginning with 3, in case you are actually dialing a local call starting
with 3.

IXXXXXX XX XX The second pattern is any eleven-digit number beginning with 1. Prefix with 9 and dial as is.

The assumption is that this is a long-distance PSTN call within North America (within North
America, all long-distance calls start with 1).

[2-9 XXXXXXXXX

The third pattern is any ten-digit number beginning with a number other than 1. The
assumption is that this is a local PSTN call within a ten-digit dialing zone.

+x.T;

The fourth pattern is a number of any length that begins with +, to indicate an international
PSTN call from North America. Delete the +, prefix with 9011 (011 is the number to access
an international line from North America).

match=2;pre="9";

For the second pattern, prefix 9 to access an outside line.

match=3;pre="91";

For the third pattern, prefix 9 and 1 to access an outside line and enter the long-distance code.

match=4;prestrip=1;
pre="9011"

For the fourth pattern, remove the + and prefix 9011 to access an outside line and enter the
international code.
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C Location of Data Files

Data files are saved in the standard location for application data. This location is typically:

<user directory>/Library/Preferences/CounterPath Corporation/X-Lite 4
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D Glossary

AEC

AGC

Broadband

Codec

Default account

Dial plan

DTMF

IM

IP

IP address
Media
MOV
MWI

Narrowband

Presence

Proxy
PSTN
RFC

RTP

Acoustic echo cancellation. Processing of the audio signal to reduce the echo effect
that can arise with a speakerphone or that can arise if the sound from the
speakerphone or headphone leaks into the microphone.

Automatic gain control. Processing of the audio to adjust the microphone volume
level so that the other party does not hear the distortion that might be caused by too
high a microphone input or too low volume (due to too low input level).

Broad or wide bandwidth. In data transmission, the wider the band, the more data it is
possible to transmit in a given time span. A cable, DSL and ADSL connection to the
network provide broadband for data transmission. A dialup or ISDN connection
typically provide a narrow bandwidth for data transmission.

The format by which audio streams are compressed for transmission over networks.

The SIP account that will be used when placing an outgoing call, if X-Lite does not
determine that another account should be used. X-Lite uses the dial plan to determine
the account to use.

The rules that X-Lite follows in order to interpret the softphone address or phone
number that the user has entered and to modify the number or address, as required, to
ensure that the call will be placed successfully.

Dual-tone multi frequency. DTMF is the system that is used in interactive voice-
response menu systems such as the menu system for accessing voicemail messages.
The DTMF system allows the user to interact with the menu by pressing keys on a
dialpad or keyboard.

Instant Messaging. A technology that lets users send text message and files for near
instantaneous delivery and display on each others’ computers.

Internet Protocol. A data-oriented protocol used for communicating data across a
network. IP is the most common protocol used on the internet.

A unique number that devices use in order to identify and communicate with each
other on a computer network using the IP standard.

In a VoIP phone call, the audio portion of the information in a call. Compare to
“Signaling”.

The Mac QuickTime multimedia container format. MOV files contain audio data in a
standard container that allows simultaneous playback.

Message Waiting Indicator. An indicator that there is a voicemail message for the
owner of an account.

In data transmission, the wider the band, the more data it is possible to transmit in a
given time span. A cable, DSL and ADSL connection to the network provide
broadband for data transmission. A dialup or ISDN connection typically provide a
narrow bandwidth for data transmission.

An instant messaging feature that allows users to share information about their
availability, mood, location and so on.

See SIP account.
Public Switch Telephone Network. The traditional land-line phone network.

Request for Comment. A document that describes an aspect of an internet technology.
An RFC may be a proposed, draft or full internet standard.

Real-time Transport Protocol. A protocol for delivering the media portion of a data
transmission over an IP network. SRTP is another media protocol.

52



X-Lite 4 for Mac User Guide

Signaling

SIMPLE protocol

SIP
SIP account
softphone address

SRTP

TCP
UDP
URI
URL
USB device

VAD

\VolIP

WAV

In a VoIP phone call, the information in a call that deals with establishing and
controlling the connection, and managing the network. The non-signaling portion of
the call is the Media.

Session Initiation Protocol for Instant Messaging and Presence Leveraging
Extensions. The instant messaging (IM) protocol followed by X-Lite. It encapsulate
the rules for exchanging instant messages.

Session Initiation Protocol. The signaling protocol followed by X-Lite for handling
phone calls.

An account that provides the user the ability to make VoIP phone calls. The account
encapsulates the rules and functions the user can access.

The address used to connect to a SIP endpoint. In other words, the “phone number”
used in a VoIP phone call. For example, sip:joseph@domainA.com.

Secure Real-time Transport Protocol. A protocol for delivering the media portion of a
data transmission over an IP network. SRTP is a secure protocol, which means that
the media is encrypted. RTP is another media protocol.

Transmission Control Protocol. A transport protocol for delivering data over an IP
network. Other transport protocols are TLS and UDP.

User Datagram Protocol. A transport protocol for delivering data over an IP network.
Another transport protocol is TCP.

Uniform Resource Identifier. A name or address that identifies a location on the world
wide web. A softphone address is a type of URI.

Uniform Resource Locator. A URI that both identifies a name or address and
indicates how to locate it.

Universal Serial Bus device. A device that follows a specific communications
standard. A headset may be a “USB type” of headset.

Voice Activity Detection. A technology that detects if audio is a human voice or
background noise. X-Lite includes a feature (Preserve bandwidth on the Network
panel of the Preferences window) that controls whether audio is transmitted when
VAD determines that no one is actually speaking.

\oice over Internet Protocol. A variation of IP used for sending voice data over the
internet, in other words, used for making phone calls over the internet.

Or WAVE. A file format standard for storing audio on PCs.
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